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TAMS Analyzer 3.00 Release Notes 

 

TA3 introduces a new layout for the workbench, a new project document structure, and 

critically, a client-server model for multi-researcher projects (note: if you are a solo researcher, 

you can still work as usual). MySQL is the first server to be supported. This client server system 

also has a special mode for “students” which allows a whole class/computer lab to download a 

project to work on. 

 

Things to note:  

 

1. TA3 creates a project directory in which all files are kept and managed. This should have 

been done in 2.00 but I’m a slow learner. This primarily affects new projects. Users 

familiar with XCode will recognize the operating procedure here: pick a location for your 

project and give it a name. Then pick create.  

 

2. Existing projects are not automatically converted to TA3 directory tree structure, though 

otherwise TA3 remains compatible with earlier TA projects. I discuss below how to 

convert your existing files to TA3 file structure which is necessary if you want to share 

your data through the server.  

 

3. The future synch information is kept in a separate file in the same directory as the project: 

This means you should not have more than one project in a directory (or the synch 

information will overwrite itself). 

 

Changes/New features: 

  
1. save as in documents now adds a new file to projects 

2. project prompts users for file name for results and documents (it puts them in the right folder) 

3. New tabbed project gui. Needed for future functionality! 

4. Project file now has tools for code creation and code set creation built right in the project 

window, though you can still use the traditional panels 

5. Project now has a part of the search panel for creating hot code lists 

6. File list now permits multiple selection 

7. Copy without line numbers 

8. Hot code list creation from the workbench 

9. Ability to create hot code sets by doing set operations on the current code list (find the 

intersection or create the union of different code sets 

10. Zoom window now stores the zoom factor for document windows 

11. Zoom now works in results 

12. Conversion function provided 

13. Select near feature in results. Provides a hierarchical view of records related to other records. 

14. Client-server now working with MySQL as the server 

15. Group by code set in results 

16. Create a hot code list of all codes not in any of the defined code sets 
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Documentation 

 

Contents 

1. The new project directory structure: 

2. Code extensions 

3. Converting to TAMS Analyzer 3 format 

4. Select near 

5. Exporting “Select near” records 

6. Grouping and exporting code sets 

 

For documentation on the client-server functions see “Using TA3 with Multiple 

Researchers” in the Docs folder after reading the following. It is too involved to detail here. 

 

1. The new project directory structure: 

 

TAMS 3 takes responsibility for placing files in and relocating files to a specific directory 

structure. When a file is added to a project it is actually copied to the tams project data (or 

results) directory. The directory structure looks like the following: 

 

 
In this release old files are not converted automatically (though see below). Furthermore, some 

new features will not work (remembering last selected tab, for instance) if you are not using the 

xml project structure. If your project is of the older type (icon doesn’t have an x in the lower 

right hand corner, extension is .tprj rather than .xtprj) you should do a “save as” to convert the 

project to the new file format.  

 

What having TAMS take this responsibility for data files means is that if you click “new,” you 

are immediately prompted for a file name. A “blank” file is created with that name and placed in 

the “data” subdirectory (these directories are created automatically for older projects and files 

created with this version are put in the appropriate folders. However, unless you run the 

conversion function, old files will remain in their previous locations).  

 

Search results are more complex. When you press the search button you will be immediately 

prompted for a result file name. You have the option of making a search result temporary, which 

means it will be trashed next time you load the project. This is because results files are often 
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exploratory and not intended to survive from ones tams session to the next. To expedite this, 

TA3 will automatically create a temporary result file with a unique name if you just leave 

the name empty and hit return when you are prompted (don’t even bother checking the 

temp box). 

 

Note that the whole temp directory is trashed and recreated each time that the project is opened. 

 

2. Code extensions 

In earlier versions of TA, hot code lists could only be created through the document new code 

field. Basically you could search for codes (and optionally definitions) for words by entering a 

phrase into the new code field and hitting return. More subtle manipulations could then be done 

through choices on the Coding->Hot code sets menu. 

 

 
 

This functionality is now supported in the workbench under the Search tab. You have the ability 

to craft subsets of codes by selecting more and fewer items, removing sets that meet criteria, etc. 

There are buttons to facilitate this or the menu items under the Coding->Hot code sets menu. 

Additionally, the dictionary can now be included or not by checking/unchecking a box on 

the workbench or through a toggle menu item under Coding->Hot code sets. 

 

TA3 adds additional functionality for code sets by allowing you to do set operations on whole 

code sets. For instance, you could have a code set of codes related to “positive student 

interactions” and a code sets of “students interactions with teachers.” You can now pull up the 

intersection of those two code sets. This is not manipulating data at all, merely the code sets so 

that you can search for codes that meet very narrow criteria. 

 
Note that all of the set operations listed above work on the current code set and do the set 

operation with the set selected by the second pop up menu.  
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Venn diagrams illustrating the results of the code set operations: 

Union: 

 
 

 

Not intersect: 

 
 

Intersection: 

 
 

Less set: 

 
 

 

 

 

 

3. Converting to TAMS Analyzer 3 format 

To facilitate moving to the new directory structure TAMS has a new conversion menu item to 

help create the directory structure and move the files into the proper folders. To convert from 

earlier (2.x) versions of TAMS do the following 

 

1. Save the project in a new empty folder as an XML TAMS Project file. The program will 

say something about saving as absolute paths, just click “Ok” 

2. Pick Project->Convert->Convert to ver 3 directory structure 

3. You will then be walked through a number of steps. First creates the directories, then it 

tries copying the files into the directories (assuming files are not already there) 

 
Answering Yes here will copy (not move) the missing files to the ./data directory 
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a. You may be prompted if it can’t find a file whether you want to remove the “dead 

record” from the project file. If you say NO you can locate the file and drop it in 

the /data directory. If you say yes you can always find the file and import it later. 

b.  
Answering yes will go through each data file looking for the !mediafile metatag. If 

that file exists in that spot it will copy it into the ./media directory of your project. If 

you have moved your media files, it will not find them, however. You can still use 

your media file by dragging them to the ./media directory yourself. The program 

always checks there for your media first (even before the directory specified in the 

!mediafile tag!). If you answer no, no attempt will be made to suss out the media files 

locations. If you have mp3’s or other media attached to your documents you probably 

will want to move them to the media directory. 

 

c. The program then report any files it could not find on the hard disk. There’s 

nothing to do here but click “ok.” 

 

d. The process then repeats itself with result files. It starts by asking if you want to 

move result files to the ./results folder: 

 

 
 

Click yes to have these results files copied to the ./results folder. 

 

e. The program then asks if you want to remove lingering, crufty, useless data that it 

is holding onto about various files that it still has data structures for. This is a 

good time to clean up the project file by saying yes to questions like: 
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f. Voilà, you are done. You now have a TAMS Analyzer 3 project. One thing you 

might want to do is to add this new project to your work menu and get rid of any 

old TA 2.XX projects from the work menu you have converted. 

 

4. Select near 

 

Select near provides a hierarchical view of the data that groups records related to other records in 

an outline structure. Select near allows users to answer questions such as “What occurrences of 

code X occur within 5 minutes of each occurrence of code Y?” “What occurrences of code set X 

are within 4 sections of the current selection?”  

 

In both of these model questions there are two sets: a base set which is defined by the current 

record selection, and a comparison set. In the first question Y is the base set and X is the 

comparison set. A set image of this relationship is suggested by the following: 

 

Base record set/selection Comparison record set

 
 

It is clear here that each base can have many comparison records assigned to it, and that each 

comparison record may be assigned to multiple base records. 
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To understand this complex new function I want to work through the 1
st
 example above. Here it 

is diagramed with its different parts: 

 

 

 

Sample Query 

 

1. To turn this into a TAMS operation, first select the records that you want to take as the 

base of the Select near operation. This is determined by the part of the question I’ve 

marked as “C,” the “each occurrence of code Y.” To do this select the _code column and 

do a simple selection for code Y.  

 

Note: any selection will work, it doesn’t have to be the _code column. It can be as 

complex a selection of records as you like. 

 

2. Pick “Select near” from the results menu. It will provide you with this sheet 
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Index to the parts of Select near dialogue 

A. Since we are looking for code X pick “code” in the “Match” box menu 1and then 

pick X from the lower menu (Menu 2).  This matches the A part of the 

diagrammed query above.. 

B. Presumably we want the comparison set to be with all of the records in the result 

file. If so, pick “All records” from menu 3. Alternatively you can use the current 

selection or a particular results set. In the latter case pick the results set from 

menu 4. 

C. If we want only to match X select check box 5; if we want anything in the X 

family leave it unchecked. 

D. If we want the matching records only to come from the same source/data file as 

the base record select box 6. If box 6 is unchecked comparison records from any 

file will be matched to the base set. 

E. According to our Query we want comparison records that are less than 5 minutes 

from their matching base records (see part B of the query). So for G we’ll pick 

“<” (within is similar to less than) from menu 7. Fill in “5” in field 8. Pick 

minutes from menu 9. If we want those 5 minutes to be before or after the time in 

the base record pick “Before and after” from menu 10, otherwise select before 

(the base record time) or after as is appropriate. 

 

Note that TA will pick the field to examine based on your choice in menu 9. For time units 

it will use the time field indicated in your program preferences, for characters it will use 
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_begin_loc, for line numbers it will use _line_number (if you are scanning for line numbers 

and have used them in your source files. To over ride these decisions use items 11, 12, and 

13. Check box 11, pick the field to search from menu 12, and indicate the type of data 

included in it from 13. You will still need to pick a comparison operator from menu 7 and 

fill in a value into field 8. 

 

 

 

 

3. At this point pick OK and the results will appear in an outline format: 

 

 
Results of Select Near 

 

4. At this point you will want to get back to the “table view” of your results. TA3 will not 

allow you to do any thing other than view results and export them from the “outline 

view.” There are three different ways to toggle back and forth between table and outline 

views.. 

A. Use the Results->Switch data view menu item 

B. Use the quick toggle button on the info bar. It will switch from O (outline) and T 

(table) to indicate which view you are currently in: 
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C. You can add an optional button to your toolbar which will toggle the two views:   

 
 

5. Exporting “Select near” records 

 

Select near results are not saved when the result file is saved. The only way to save these results 

is to export them with the File->Export data menu item. 

 

First make sure that your results window is showing the results of your select near search. In 

other words, the result window must be in outline view. Pick File Export data and you will get 

an export data pane with some additional fields and altered text from the one for the table view: 
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Modified Export Data dialog 

 

The dialog functions exactly as the export function did before: select the columns you want 

exported on the left; you can rearrange the order (drag and drop) to meet your needs, and you 

have a variety of formatting options, both preset and user defined. 

 

Remember that the fields can include escape characters. So if you want an extra space before 

each level 1 headline fill in “Main row prefix” with “\n” (new line character). “\t” means tab. 

 

The first check box is modified to allow you to only export what is expanded or visible or to do 

export all of the results.  By expanded, I mean “are the sub rows showing?” 

 

When you hit export you will either be prompted for a file name or your data will be waiting on 

the clipboard. 

 

Click exit to leave the export dialogue. 

 

6. Grouping and exporting code sets 

 

TA3 also adds additional power to the code set concept. Marked records can now be used to 

generate a code set using the “Results->Turn marked to code set” menu item. More important for 

many is the ability to create a code set report including counts of records. Given a shown 

selection, TA3 will create a hierarchical display showing the code set and count at the top level 

and all pertaining records underneath. Any given record will appear under as many code sets as 

is applicable. To generate this just make the selection of the records you are interested in 

analyzing and pick “Results->Group by code set”. This is what you will see: 
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Results of group by code set 

 

You can see that the code set name is held under the “_code” column and the count of records is 

held under “_data”. In the above example you can see that 4 records had codes in the “real” code 

set from the shown selection.  

 

Export works as described above in section 5. TA3 tries to be smart about the rows and always 

prints out the code set name and count using the prefixes and separators you indicate. The 

subrecords are formatted using your choice of columns and delimiters. 

 

Note, clicking on a code set (level 1) row does not change the display. Clicking on a level 2 row 

will show the data associated with the selected row. 

 

Note, if you would like an exact match of the codes in the records and the codes in the code sets 

select the Sort options->Case sensitive flag. 

 

 

Happy coding. Joyous analysis. 

 

 



TAMS Analyzer 3.1 Release Notes 

 

TA 3.1 adds powerful new reports including counts and graphs of variables (context codes) and 

code sets (Reports->Graph code sets, chosen with a result window in front), of code sets 

relations to codes and to each other (Same menu item chosen from with the work bench window 

in front), and a code definition and code set definition report (Reports->Code set definitions, 

work bench needs to be in front). Document searches have been updated to have the same 

interface and naming process as work bench searches. Default font can now be set for document 

and result windows. Blanks field entries can be either thrown out or counted as “zero” in select, 

select near, and auto sets. Improved diagnostics… AND MORE!!! 

 

New features 

• Added complex reports so that you can count matches of variables (table columns) and 

code sets; this can be generated as .dot or .html 

• Added report for the relationship of codes to codesets 

• Added definition report for code sets and hot code list 

• Added font preferences for doc and results in project 

• Added "blank = 0" check-box for select, select near, and auto sets 

• Document search now works same as workbench search  

• Same folder mode now obviated, deprecated and demolished by relative file mode and 

the new folder structure 

 

Bug fixes 

• Fixed outline view so you can use up and down arrows 

• Fixed isParentOf function which may affect different options 

• Fixed !if so that it works with !name (remember that the universal for !name is 

FileName) 

• Fixed prompts for regex search on workbench 

• Improved check pair diagnostic and  

• Tweaked the way file names are handled so that if a path exists the file name is returned 

even if the file is a fiction at that path location 

• Changed permission to save project to isReallyOpen from hasFile 

• Tags are colored for new files. 

• Improved hunting for files for relative and same folder project types 
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TAMS Analyzer 3.20a3 Release Notes 

 

New features: 

• On the fly table columns in results (see documentation, 3) that can be selected, counted, 

sorted, graphed, and used to mark up source documents with universal and context codes. 

• New table report that allows you to compare text and counts side by side for different 

variables organized by code or code set (see documentation, 1) 

• Ability to mark and unmark records in outline views 

• Ability to convert marked to a code set from outline view 

• Ability to copy ruler styles from document to document 

• AND and OR buttons on the search tabs 

• Tool bar buttons in results windows for compare data, group code sets and graph code 

sets 

Bug fixes 

• More careful pruning of files when a project is opened. If a file can't be found the user is 

prompted as to whether they want to remove it from the project 

• Double clicking code in search windows now works 

• Export codes and defs now creates a proper project file in the data directory; definitions 

are trimmed 

• More saving using “Export result file formats” in the program preferences search tab, 

including data export and the new html based reports. This should help foreign language 

users (see documentation, 2) 

• Graphviz documents now hard coded to be utf-8 format to support at least other non-

english, roman charactersets. 

 

Documentation 

 

1. Reports->Data comparison table 

 

This is an HTML report generated from a result window that opens up in your default browser. It 

presents either counts, like the data summary, or the actual text of various columns of the result 

window in a table structure. The column heads are either the code sets defined in the project or 

the codes of the data currently selected. The rows are the values from one of the columns 

representing either a context or universal variable. What is filled in in the table are the values 

from the fields selected from the table, as well as the count. The idea here is that you can directly 

compare what different people said that you coded X. Unlike the results window which shows 

you one piece of data at a time, the data comparison table puts comparable data next to each 

other for your purusal. Note: it is not doing the comparison, you are; it’s just giving you a format 

that allows you to do so. Also, like dot graphs, an ethos of less is more (revealing) holds here as 

well. Generating a 200 by 40 table of all your codes matched against all your interviews will be a 

mess to navigate, at best. So here’s how it works: 

 

The data, as always in TA, comes from the current selection: When you pick Reports->Data 

comparison table you get this dialogue, which looks slightly differently depending on whether 

you have selected “Codes” or “Code sets” from menu #1 
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Data Comparison Table Dialogue 

 

If you pick “Codes” from menu #1, items 4 and 6 will show, but the code set list (table 12) will 

be empty, since; if you pick “Code sets”, items 4 and 6 will hide, and all of your code sets will 

appear in table 12, as seen on the right screen shot.  

 

The default table will have the codes or code sets across the top. The rows will represent the 

values from the column you choose from menu 3. If you want to reverse the columns and rows, 

click on switch #2 “Switch axes”, which will put the codes (or code sets) down the table, and the 

values of the field selected on menu 3 across the table.  

 

For a code data comparison table, the default table will use only the codes from the currently 

selected rows. If you check box 4, the current code list (from your work bench) is used as the 

basis. Only rows in the current selection that have a code included in the current code list will 

appear in the table. Use the exact switch (item 5) to determine whether the codes of the current 

selection have to exactly match the current code set (a>b will not match a) or not (a>b does 

match a, it’s in its family).  Note: the exact switch is only visible if item 4 is checked! 

 

For a code data comparison table you can group codes together by setting a code level. This is 

just the same as with autosets and other tables. If you put “1” into item 6 you a>b and a will be 

treated as the same. If “0” is entered all levels are matched. 

 

For both types of tables (codes and code sets) you can use switch 8 to include a count with your 

data. You can also provide subcounts of the cluster of fields chosen in table 9, by checking box 

7. Note that this does not give separate counts for the data selected in table 9, but of the fields in 

table 9 treated as a single entity.  

 

The data you include in your table is selected from item 9. You can drag to rearrange and 

multiply select the information you want to compare in your table. If you are including your 

“_data”, which typically you will, you can have the program remove or include tags as well as 

convert escape characters (\n for a new line, \t for a tab) using items 10 and 11. 
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For code set data comparison tables you will be provided a list of project code sets in item 12. 

You must select the code sets you want included in your table from this list. The codes from 

records from the current selection in your results window are compared to the code sets either 

exactly or not depending on the state of item 5. Otherwise the choices are similar. You must 

choose a universal or context value from menu 3, you have the option to have counts printed in 

the table, you pick the data you want to compare from table 8, and items 9 and 10 determine how 

_data information will be formatted.  

 

The report you get simply allows you to see the value of a code (or code set) across files: 

 
Screen shot of a data comparison table 

 

2. Saving files and using reports with non-English character sets. 

This release extends the ability to save files using different character encodings. This is very 

important for users that are working in non-English, or non-ASCII character sets. Export data 

(when you save data to a file, not to the clipboard) and the html reports generated by “Graph 

code sets” and the “Data comparison table” use the information in the program preference panel 

under the “Search” tab: 

 

 
The character set option in program preferences 
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Note that this does not affect graphviz documents and reports. Those are now generated using 

utf-8 format, which will at least support some additional, non-English, character sets, but cannot 

support many (any?) non-European character sets. 

 

3. On-the-fly, temporary data columns 

Now tams results windows allow you to create new columns on the fly. These don’t change the 

source files (initially), but they allow you to group and select data and create analysis tables 

using emergent categories. The data in these columns can be created through setting values 

directly (double clicking on a cell), setting values for the selected records (or marked records),  

and by cascading values so that blank cells take their contents from the ones above them. 

 

 
The “Temporary column” submenu of the Results menu 

 

While temporary columns and their contents are saved if the result file is saved (as a non-

temporary result file), they are destroyed if you refresh or do anything thing that refreshes results 

windows (check your preferences!). For most of the functions listed in the submenu, you must 

select the column by clicking its header. When you add a column you fill in this dialogue: 

 
The add column dialogue 

The column name is the only required field. The program fills in the default value for every 

record. Then it goes through the selected records and fills in the value in the “Selected value” 

field. It does this even if both are blank. 
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DANGER 

The temporary columns can also be used to code at both the !universal and !context levels your 

source documents. Playing with these features can potentially scramble your data files, are likely 

to have unintended consequences, and if used more than once—will cancel earlier uses of these 

features in unintended ways. But if you want to play with fire here are some implementation 

notes. 

 

You can set a repeat value using the !setcontext. What tams will do if you pick “Add code using 

column” will be to insert “{!setcontext X=“Y”}, where X is the column title, and Y is the value 

in X for that row. If you have 3 or 4 rows of a result window with nested codes marking the same 

data, you can imagine the sort of mess this can leave in a file. 

 

Somewhat, but only somewhat, less dangerous is the “Create universals using column” feature. 

This will first check that only one value in the selected rows applies to any file and will inform 

you if more than one applies (without doing anything). If it finds that one value maps to each file 

(though the same value can apply to many files), then it will go through each file represented in 

the selection and insert at each one’s start a {!universal X=“Y”} metatag where X is the column 

head and Y is the value for that file.  

 

Both of these features also alter the init file of the project. “Add code using column” inserts a 

{!repeat X} where X is the column title at the start of the init file. “Create universals using 

column” inserts a {!universal X=””} at the start.  

 

Use at your own risk!!! REMEMBER YOU CANNOT UNDO THIS!  

 

So to recap: Add columns, that’s safe. Just be careful if you use the two menu options 

which tinker with your source files 



TAMS Analyzer 3.21a6 Release Notes 

 

New Features: 

• automatic generation of !if based on on-the-fly table columns (See documentation) 

• Data comparison table improvements 

o ability to group without count  

o ability to set the vertical and horizontal justification for different table elements 

o ability to sort each axis (or not) 

o ability to make a table from any two data columns rather than just codes and code 

sets 

Bug Fixes 

• close button eliminated in new dialogues 

• various menus are now constructed more carefully by checking the universals and repeats 

values 

• closed file handling is improved 

• fill selected and fill marked now operational 

 

Documentation: 

 

You can now automatically generate an !if table based on a temporary data column. An !if table 

is simply a series of !if statements which set the value of a variable based on the value of a 

different variable. TAMS only looks at the selected rows when setting up the !if table. To create 

an {!if X=”Y” => A=”B”} statement TAMS will use the name of the temporary column for A, 

and the values in that column as B. When you pick “Results->Temporary column->Generate !if 

table” it will prompt you for the column to use as the source for X and Y. Pick the column from 

the pop up menu and then the name of the column will be X and the matched values will serve as 

“Y”. You must have a designated init file for this to work. Also, you will not be allowed to 

create the table if there are conflicting assignments, i.e., if in your selection for a given (X,”Y”) 

set of pairings there are both (A, “B”) and (A, “C”). 
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TAMS Analyzer 3.22b9 Release Notes 

 

New Features: 

1. Data comparison tables now are rendered in tams with an option to load the tables in your 

browser (requires that webkit is installed; for panther/tiger users this isn’t a problem. 

Jaguar users will need to run Safari to install webkit on their machines). See 

Documentation. 

2. Data comparison tables now calculate totals if count or “Group and subcount” are 

selected. 

3. New ways to work with temporary data columns 

a. Convert selected records to lower, upper, or title case. 

b. Copy values from another column to a temporary column 

c. Set value now can append the given value to the temporary data column 

d. Use regular expressions to transform temporary data columns 

4. Data summary table dialog now stays open until the “Exit” button is clicked. This allows 

the user to generate multiple tables before exiting the dialogue. 

5. Better white space stripping in various operations that alter code definitions 

 

Documentation 

 

In this version of TA, data comparison tables are linked back to the data. You can either have TA 

pick out the item from the current selection or select it (so only those items are showing). The 

idea here is that you can use the TAMS web windows to explore your data but then pop the data 

open in your browser to print it (looking at linked text for a long time can drive you crazy!) 

 

So I want feedback on this. How does it work for you? Is it too complicated? How would you 

like it all to behave? How might it be laid out better? 

 

Just so that you see the new logic, here is my little dot graph of how it all works: 

 

 
Logic of running data comparisons 
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So the way to work the new data comparison dialogue is to set the parameters for a table, then hit 

show report. This switches the window to the preview mode, which lets you see your table (and 

use it: you can click on any cell to highlight or select that data). Now you can go back to the 

“Settings” tab to modify the table until it represents your data as you wish. At this point you can 

spin off windows for the tables you like from the preview tab by clicking “Open in new 

window”. This step is necessary since the preview will change as you keep making data 

comparisons, so either spin it off or you’ll need to regenerate the report. For more control, over 

printing, over font size, etc., you can open the table in your browser. Note that both in the 

preview tab, and in windows spun off from the tab, you can choose to highlight, select, or add to 

current selection, the data you click on. 

 

One hint: If you are selecting rather than just highlighting records, and you then return to 

highlighting, the records you want to see will probably not be in the current selection. Use the 

back button of the browser to get back to the selection state you need. 
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TAMS Analyzer 3.23b1 Release Notes 

 

New Features: 

1. Word count across all documents in search list (See documentation pt. 1) 

2. Word count on select fields of result windows (See documentation pt. 2) 

Bug Fix: 

1. Hot code list on workbench fixed so that selecting code list (or other item) doesn’t trigger 

a hot code search 

 

Documentation 

 

1. Project word counts 

 

This release adds the ability to count words (defined initially as a series of letters) across all files 

in the current search list. From the workbench pick Reports->Word count. You will then be 

asked if you want to “sort by words” (i.e., alphabetically). If you click “yes” the count will be 

presented in alphabetical order, otherwise the list will be in frequency order with the most 

commonly used words listed first. The report will break down word use by document and with 

totals and grand totals. 

 

What is a word? 

By default a word is just letters. This leads to some problems: the word “don’t” for instance will 

be considered 2 words. To add additional characters to what defines a word pick “Project->Word 

count options…”.  Simply type in the additional characters you want to be considered when 

defining words. To add numbers, for instance, and the apostrophe type in “0123456789’” (in any 

order). Click “Ok”. Now run your word count… 

 

Saving a word count 

The word count is rendered as an HTML table. If you wish to save the table, click the save 

button at the bottom of the table, this will prompt you for a file name. The table will be saved as 

a tab delimited (rows terminating in a new line character) file, which is great for Excel and other 

databases and spreadsheets. If you wish to save a word count report as html, click the “Open in 

browser” button and use your default browser’s “Save as” to create the file for the table. 

 

Note, word count examines the file without tags. If you wish to know how many tags/codes you 

have, you will need to use the Code count report. 

 

2. Result window word counts 

 

A more complicated type of word count can be generated from result windows. Here you can 

count codes not just by file, but grouped by the values of any table column. There are some 

serious problems that can arise with this, since simple searches can return the same text multiple 

times (i.e., if a passage is coded twice, it will have 2 rows in a result window, and the words will 

be counted twice in the word count). So you need to know what you’re counting and why.  

Generally you will want to select a very small subset of your data, for instance chosing one code 
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(that should prevent the problem just mentioned) and examine the words people are using for 

that single code. 

 

Note that result windows use the “Project->Word count options” to determine what counts as a 

word. 

 

With a result window in front, picking “Report->Word count” results in this dialogue: 

 

 
Results word count document 

 

The first menu (“Count words in column”) determines what words to count. The second menu 

(“Group by”) groups the counts by the values in that column. Picking gender in the “Group” will 

break the counts by gender: 

 
Word count by gender 

The last menu item indicates to TAMS whether the data should list the words in order of 

frequency (count) or alphabetically. 

 

Again, clicking “Save” will save as a tab delimited file. 



TAMS Analyzer 3.23b2 Release Notes 

 

This release adds one small, but powerful feature to data comparison tables and fixes two 

formatting problems with the tables. There is now an “empty” check that will appear for a 

couple of search types in the “With field” box. This will return values of the field picked 

in the “With field” menu and display them even if they have 0 matches with the field 

picked in the “Compare” box. This way you can identify immediately who did not have 

code X, Y, or Z. in their file, for instance. There are only two types of searches where this 

is available. If you are using “Codes” in the “Compare box” and you check the “Use 

current code set” box, then you can check the “empty box”. In addition if you pick code 

sets, you can see which values of the “With field” field do not have codes in the selected 

code set. 

 

New Feature 

• Empty flag now implemented for code and code set searches 

Bug Fixes 

• Corner “grand” total column does not inappropriately get created. Previously, it 

would show even if there was no vertical count column. 

• Division bar not printed if count is 0 

 

 

Documentation 

Empty flag in Data Comparison Reports 

 

Previous versions of TA in the Data comparison report, only reported counts greater than 

0. In this example I am looking at how many of my interviewees (n = 7) used code 

unreal.  

1. I create a hot code set from my desktop for “unreal,”  

2. I create a simple, unlimited search (i.e., I just click the search button on the 

workbench without using a search string) 

3. I pick “Reports->Data comparison table” 

4. For the “Compare” box, I pick codes 

5. I check the “Use current code set” box 

6. I check the exact box 

7. For the “With field” box I pick “_doc” from the pop up menu 

8. From the Data elements box I check “Include count” (leave everything else as is) 

9. Click generate report and I see something like this in the preview pane: 

 

 
Results from not using the empty check box 



As you can see four of my interviewees  used unreal. But what if I had enough other 

interviewees that I would want to see who didn’t use unreal. In other words, those with a 

count of 0 don’t show up. To remedy this just press the settings tab and click the “empty” 

switch in the “with field” box. Click generate report and now I see: 

 
Same report with “empty” checked 

Now I see explicitly that Cyndy, Darla and Xander did not use unreal. 

 

The same logic also works with code sets. To see who does not have a code in a 

particular code set check the empty box. 

 

 



TAMS Analyzer 3.30b1 Release Notes

New features

1. Ability to make virtual “end”s either end’s or endsections.

2. Ability to create contextual variables that reset at endsections, ends, end of files

(eof) or never.

3. New code and add code now have menu items and key equivalens (Document

window)

Bug fixes

1. Result file resize bug: often the browser panel would disappear or strech in

bizarre ways if a window was resized

2. Generate code list now is operational again

3. Scan for line number partial fix

4. Fix for remove files for multiple selections

Documentation

To understand the changes implemented in this release it is important to understand how

TAMS handles context and universal variables

How context and universal variables work (up to this version)

When TAMS reads through the init file and the files in your search list it creates an

account for each declaration of a universal or context variable it finds. As it scans the

document, if it’s a structured file (i.e., it uses !last, !first, !end, !endsection, or !struct) it

keeps track of what each context/universal variable’s value is, it also creates a list of all

the coded passages it finds. Here’s the important point: it doesn’t match up the coded

passages to the context and universal variables until it hits an !end or an !endsection (or a

virtual one placed there by a !last or !first tag). At that point it matches the values of the

context and universal variables with the coded passages and creates one row in the result

window for each coded passage. If it is an unstructured document every time it hits a

coded passage (the end tag of one) it matches the values of the universals and repeats

with the coded passage and creates a record right there and then in the results window.

Now before this release (3.3), if in scanning a structured document the program hit an

{!end} tag, the program would clear away all the values of the context variables after

creating the record in the results window. If it hit an !endsection tag, it would create the

row in the result window but not clear the context variables. The values would just

cascade through to the end of the document. Universal values cascade through regardless

of !end and !endsections.

Unstructured documents simply treat every coded passage as if it has an !endsection

before it, letting values cascade to the end of the document.

What’s new? Controlling virtual ends



The !last and !first metatags, up to this version, stuck  virtual !endsections through the

document. Declaring {!first X} meant that every occurrence of  X was treated as having a

!endsection in front of it; {!last X} meant that the next context code that appeared after X

occurs was treated as having an !endsection in front of it.

Starting with version 3.3, researchers can decide on the fly whether !last and !first create

virtual !endsections or virtual !ends (the difference being that context codes are blanked

out after !ends.

To set whether !last and !first create !ends or !endsections use the {!virtualend} and

{!virtualendsection} tags in your init file. The program defaults to {!virtualendsection} if

you do not indicate which you prefer (which was the former behavior of the program).

This is particularly powerful when mixed with the new ability to create variables with

specific “horizons”.

Unified variable space

In previous versions TAMS kept separate “accountings” of context variables and

universal variables. There were two sets of books: one for universals the other for

contexts. That is why !if statements and !map statements had to connect similar variables

(context to context; universal to universal); you were not allowed to map a context

variable onto a universal variable or vice versa.

In this version variables are all accounted for in the same log book, which now enables

that sort of mixing. More important, the variables can actually switch their type. Basically

what TAMS tracks are two properties of a variable with a given name (say X). First it

tracks the value of the variable (e.g., whether a variable named "sex" is currently set to

“m” or “f”) and the horizon of the variable. The horizon indicates what triggers a variable

to clear its value. Previous versions of TAMS would only clear context variables at an

{!end} tag, and a universal at the end of the file (eof). This version allows you to clear

the value at an endsection, an end, an eof (end of file), or never. These points represent

the horizon of the current variable, the point at which its value is blanked out (in

technical terms, changed to an empty string). So in the new way of thinking, context

variables are simply variables whose horizon is “end” and universal variables are ones

whose horizon is “eof”. Now there are two other possibilities. You can have variables

that get their value wiped at !endsection or never get their value scrubbed at all!

To manage this, TAMS 3.3 introduces a new metatag: !var (for variable). This metatag

lets you set a combination of the name, value and horizon of a variable, separated by

commas:

{!var name="City", horizon="endsection", value="NYC"}



Note that name, horizon, and value can happen in any order. Also only name is required.

{!var name="City"} is the same as {!var name="City", value="", horizon="end}, if a

variable "City" has not been created (through !var, !context, !universal, etc.) earlier.

If a variable "City" has already been created then only the listed properties (value and/or

horizon) are changed. In other words if a variable City is already declared {!var

name="City", horizon="eof") only changes the horizon, not the value.

So !var combines the ability to declare variables, set their value, and set their horizon at

the same time.

A single !var metatag can declare several variables by separating them by a semicolon:

{!var name="City"; name="Gender", horizon="never"}

If this were placed at the top of the init file it would create two variables: "City" with an

initial value of "" (nothing) and a horizon of "end" (that's the default) and a second

variable "Gender" which never is wiped out and also has a blank ("") value.

So what happens to legacy calls like:

1. {!context gender, city}

2. {!name "My doc"}

3. {!universal type="Interview"}

??? TAMS 3.3 just saves them in the same accounting system, treating them as if they

were created with the following:

1. {!var name="gender", horizon="end"; name="city", horizon="end"}

2. {!var name="FileName", value="My doc", horizon="eof"}

3. {!var name="type", value="Interview", horizon="eof"}

An example

Someone asked me recently to help with the following problem. Given an interview like:

{time}00:01:20{/time} {name}Bob{/name} Come here often?
{time}00:01:25{/time} {name}Sally{/name} First time, you?
{time}00:01:30{/time} {name}Bob{/name} Every day!

They first wanted to structure it using !last, with time and name as context variables::

{!context time, name}{!last name}
{time}00:01:20{/time} {name}Bob{/name} Come here often?
{time}00:01:25{/time} {name}Sally{/name} First time, you?
{time}00:01:30{/time} {name}Bob{/name} Every day!



This basically stuck a virtual !endsection in front of every {time}, except the first one

(since no variable named "name"  was used before then). To TAMS the data now looks

like this, because of the !last statement :

{!context time, name}{!last name}
{time}00:01:20{/time} {name}Bob{/name} Come here often?
{!endsection}{time}00:01:25{/time} {name}Sally{/name} First time, you?
{!endsection}{time}00:01:30{/time} {name}Bob{/name} Every day!

Now the researcher wanted to add some cultural information about Bob, so he declared a

new variable "culture" and used !if to assign it to Bob. Note this is what is in the

document window, not what TAMS sees (I've removed the virtual !endsections)

{!context time, name, culture}{!if name="Bob"=>culture="Canadian"}
{!last name}
{time}00:01:20{/time} {name}Bob{/name} Come here often?
{time}00:01:25{/time} {name}Sally{/name} First time, you?
{time}00:01:30{/time} {name}Bob{/name} Every day!

The problem he had was that when he searched, Sally turned into a Canadian as well,

since !endsection does not clear the value of !context variables, and no other value had

been assigned to Sally as her "culture".

One solution would be to make "time" a universal code, though universals are designed

to be constant over the scope of a whole document. Another solution might be to

hardcode !end's before each value of {time} (not too bad with regular expressions).

However, it uglifies the data. With TA3.3 he could also make !last create virtual !ends

rather than !endsections, which would accomplish the same thing without the

uglification.

So what our researcher would type would be:

{!context time, name, culture}
{!if name="Bob"=>culture="Canadian"}
{!virtualend}{!last name}
{time}00:01:20{/time} {name}Bob{/name} Come here often?
{time}00:01:25{/time} {name}Sally{/name} First time, you?
{time}00:01:30{/time} {name}Bob{/name} Every day!

!virtualend tells TAMS to create implied !end statements rather than !endsections with

!last. And what TAMS would see would be this if the virtual !ends were to be made

explicit.

{!context time, name, culture}{!if name="Bob"=>culture="Canadian"}
{!virtualend}{!last name}
{time}00:01:20{/time} {name}Bob{/name} Come here often?
{!end}{time}00:01:25{/time} {name}Sally{/name} First time, you?
{!end}{time}00:01:30{/time} {name}Bob{/name} Every day!



In this case, this would work because every speaker also has a time code. In my

interviews this wouldn't work because I don't enter a time code for each person. I may

have several turns of conversation after a given time code. In other words, I want time

codes to trickle down (which they wont because !end clears context codes, which

includes "time"), but I want culture codes to be wiped. So the better approach might be to

let !last be !endsection, as before, but to indicate that culture's horizon is an !endsection,

and time's horizon should be the end of the document (or even !end, in this case, since

there are none!):

{!context time, name, culture}
{!var name="time", horizon="eof"; name="culture", horizon="endsection"}
{!if name="Bob"=>culture="Canadian"}{!last name}
{time}00:01:20{/time} {name}Bob{/name} Come here often?
{time}00:01:25{/time} {name}Sally{/name} First time, you?
{time}00:01:30{/time} {name}Bob{/name} Every day!

Now "time"s will carry forward, speaker to speaker til the end of the document, while

"culture" will be wiped clean for each speaker! Note that it is redundant to have "time"

and "culture" declared as context variables here, since !var will create those variables if

they don't exist. So I could have just done:

{!context name}
{!var name="time", horizon="eof"; name="culture", horizon="endsection"}
{!if name="Bob"=>culture="Canadian"}{!last name}
{time}00:01:20{/time} {name}Bob{/name} Come here often?
{time}00:01:25{/time} {name}Sally{/name} First time, you?
{time}00:01:30{/time} {name}Bob{/name} Every day!

I could also have rolled name right into the !var statement:

{!var name="name"; name="time", horizon="eof"; name="culture",
horizon="endsection"}
{!if name="Bob"=>culture="Canadian"}{!last name}
{time}00:01:20{/time} {name}Bob{/name} Come here often?
{time}00:01:25{/time} {name}Sally{/name} First time, you?
{time}00:01:30{/time} {name}Bob{/name} Every day!

Figure 1: Sally is not Canadian, and all is right with the data
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TAMS Analyzer 3.31 Release Notes

New features

1. Co-occurrence report

Bug fixes

1. Word count function restored

2. rtfd support restored

Documentation

Co-occurrence Table (on Report menu)

This release adds a report that is something akin to the quantitative idea of correlation. It

allows you to track what variables are related each other. To conceptualize what this table

tells you, you have to understand that three independent things are tracked:

1. a watched variable: this is the variable you want to compare

2. a group variable: this defines what constitutes a co-occurrence only if this variable

shares a value with the watch value will it be tracked

3. a count variable: this defines what data is monitored when the group variable is

shared.

Example of using this report.

1. Given a set of group interviews where I have coded (probably using the !if

statement) such things as sex, culture, age range, etc. I could ask what cultures

were involved in the groups for each member of the database (especially useful if

one person is in more than one group). In this case my watch variable would be

the whatever my interviewee column (i.e., the column that names the person), my

count column would be culture, and my group column would probably be _doc or

FileName (assuming 1 document = 1 conversation).

2. Given a summary document describing who participated in a series of interactions

like this:
{!name "file1.rtf"}
{!context conversation}

{conversation}1{/conversation}
{name}bob{/name}
{name}sam{/name}
{name}lilly{/name}

{conversation}2{/conversation}
{name}bob{/name}
{name}fred{/name}
{name}austin{/name}

{conversation}3{/conversation}
{name}fred{/name}
{name}sam{/name}
{name}mac{/name}

{conversation}4{/conversation}
{name}lilly{/name}
{name}sam{/name}
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{name}mac{/name}

I can analyze the interaction among people by

a. Doing a search with raw turned off

b. Running the co-occurrence report with

 i. Watch = _data

 ii. Group = conversation

 iii. Count = _data

So the dialogue will look like:

Running the report will indicate which people interacted with whom, both by group and

overall with different sorts of subtotals depending on which option boxes we checked:

If the show count box is checked the number of instances of each counted variable are

indicated in an adjacent count box, with an additional "Show totals" box checked a total

count is presented below, as in the above screen shot. If "Show totals" is checked but not

the count, then only the number of different instances is indicated, i.e., with the

redundancies removed. This provides a very different "count" of the interactions.
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Note: The group variable assumes that each group is defined by a unique name. You may

have to play with temporary table columns to achieve this.



TAMS Analyzer 3.31 Release Notes 

 

3.31 Build 4: 

Bug fixes: 

1. Fixed Applescript set-up so it works with VPedal, a USB foot pedal (www.vpedal.com). 

2. Kludged a fix for “Play media” from a results window. There is now a play/stop button. 

Hopefully Apple will fix things so that sheets will enable NSMovieViews. The media 

player also works with VPedal (has the same keyboard mappings as the document media 

player).  

 



TAMS Analyzer 3.31b5 Release Notes 

 

This release provides updated source code that compiles to universal binaries. It also has a 

compiler flag defined in tams.h (DISSERTATOR) which if #defined compiles to a single user 

version. Single user releases are identified by su in the disk image name. Multiuser releases are 

identified by mu in the disk image. Also projects say “Single user version” on the info tab. The 

buttons that control multiuser sharing of files are rendered invisible: “Synch,” “Manage users”, 

“Check in” and “Check out”. 

 

Note as of this release date Graphviz has not been released as a universal binary, so those reports 

that use Graphviz.app may or may not work. 



TAMS Analyzer 3.31b8 Release Notes 

 

This is a bug fix release. Repairs include: 

 

1. Check for Pairs from the project has been fixed so that it handles end of files properly 

(See notes below) 

2. With temporary columns copying the _doc column works correctly 

3. Save as in results file now works correctly and doesn’t crash the machine or lose the 

renamed file 

4. Save as in document file now saves the file correctly the write format. This caused a lot 

of problems since saveing a file with tags lost most of the tags (they were being 

interpreted as rich text format commands which also use “{”. 

5. _doc column now collapses up and down properly 

 

Notes: 

Check for pairs has one known bug, which seems to be related to Apple’s cocoa system. If the 

last character of file is a } rather than a return, the brace is invisible to tams, for some reason. 

This means that TAMS will complain of an unmatched pair. Simply add a return at the end to 

correct the complaint. 



TAMS Analyzer 3.32b4 Release Notes 

 

This release includes the following changes: 

 

• Code level option for data elements of the Data Comparison table 

• Group but don’t count duplicates for data elements of the Data Comparison table 

• Option to fold some results window dialogues (see program preference) for use on small 

screens with low resolution 

• General interface improvements (especially in Data Comparison Table) 

• Bug fixes for tamsadmin log in for multiple users 

• Bug fixes for saving the variable space and temporary columns in results files 

• Bug fix for setting dirty flag for temporary column operations 



TAMS Analyzer 3.33b5 release notes 

 

TA 3.33 includes some fine tuning of features in previous releases. These include 

 

• The ability to set end times as well as start times 

• The ability to fine tune the position of the scrub bar. 

 

These features all have their details set in the program preference panel. End times are triggered 

by option-clicking the “v” media player key: 

 
The amount of fine tuning of the player is set in the program preferences: 

 

 
 

To move backwards option-click the << key. To move forward option-apple click the same (<<) 

key, also to forward space the bar just apple click the << button. 

 

• The ability to sort the search and file lists on the project window. Just option-click the 

shuffle up and down buttons. 

 



TAMS Analyzer 3.34 Release Notes 

 

TA 3.34: 

New Features: 

1. text encoding other than ascii now supported (e.g., utf8) for source documents by 

selecting the file type from the preferences menu:  

 

 
 

 Note, that the same encoding scheme across all text files in the project. Supported 

encodings: 

 
 

Important Fix: 

1. The interface has changed so that support for Jaguar has been restored. Basically, my use of 

setHidden: in the project window and data comparison sandbox has been tweedled so that it 

becomes a setEnabled: for jaguar users. 



TAMS Analyzer 3.34b6 Release Notes 

 

This is a bug fix release. It corrects problems introduced in the release of version 3.33, 

which added option click modifications to the media player buttons. These modifications, 

unfortunately, overrode the keyboard shortcuts for the basic operations (Backspace, etc.). 

These are now restored. 

 



TAMS Analyzer 3.34b7 Release notes 

 

This is a bug fix release. This release solves the following problems: 

 

1. A bug is fixed which accidentally enabled the “New Code” menu item from the 

coding menu when the workbench is selected. Choosing this item would lock up 

the program and corrupt the project file. See note below. 

 

2. A number of bugs were fixed that prevented the last code in the code list to be 

deleted. Also there were problems with using the code browser to delete codes 

and then switching to the workbench. 

 

 

Note on the corruption of project files. This is a note to myself as much as others that run 

into this problem. The project file is corrupted in the following way. Adding the new 

code saves two arrays of dictionaries with fake items that ultimately prevent it from being 

reopened. To correct the problem open the project file in a text editor (you may have to 

temporarily change the extenstion to xml or txt). Find the list of codes. Scroll previous to 

this and find just prior two arrays of dictionaries. These will have one more object in 

them than exist in the list of codes. Delete the last entry in both arrays and save. 



TAMS Analyzer 3.35b5 Release Notes 

 

TA 3.35 introduces a number of changes to improve useability: a better project opener 

and a search button on the file tab in the project window; it also now calculates the 

location and length of data discounting the space taken up in the file by metatags and 

tags. This is used in select near now for character searches (find records less than 50 

**characters** from the current selection. It also means that users can see the length of 

their data strings (not counting tags) in the result window. This has only been tested on 

simple searches. 

 

Changes: 

1. New Project/Work selector. Working projects are now presented on a table rather 

than menu 

2. _end_loc  now shown in results table 

3. A series of columns: _bare_loc, _bare_end, and _bare_len are now included in 

results, these keep track of the location and length of the data string indexed and 

measured as if the file had ntags and metatags. 

4. Select near now uses _bare variables rather than _begin loc and _end loc. 

5. Search button has been added tthe file tab of projects. This uses the values 

indicated on the file tab. 

6. {!blockcontext} metatag. Once found the program treats all context codes applied 

tpassages of text as regular codes. 

7. File tab of project window now uses square buttons 

8. The type of select near drops specific reference to _begin_loc; in fact it uses 

_bare_loc. 
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TAMS Analyzer 3.40b14 Release Notes 

 

• New features 

1. Remove work project button on new project browser 

2. Data comparison has a single column option which basically automatically 

creates a temporary column and groups all the data you want in that 

column** 

3. Improvements to count column (didn’t like the old look); hope it works 

4. Temporary columns now can be created that calculate length, average and 

count based on regular expressions: see “Analyze” menu option in the 

Results->Temporary Column submenu** 

5. Temporary columns now can be filled with the row # 

6. Strip tags function for temporary columns 

7. Temporary columns can be created from existing columns in one 

operation (Add copy of current column); previously users had to create a 

new column in one operation, and then copy the old column in a second 

8. Group by column** 

9. Toolbar buttons added for Copy to temporary column, Add copy of 

current column, Regex transform of temporary column, Analyze 

temporary column, and Group column. 

 

 

• Bug fixes 

1. Small results browser present in all builds 

2. Small results browser has updates to (I hope) the same as regular results 

3. Work menu and new project browser synchronize 

4. !if tags created from temporary columns now have spaces removed so that 

they are proper (more or less) variable names 

5. Major fixes in export of outlined data (group by column or code set) 

6. Code definitions not restored when flipping tabs 

7. Fixes to Delete code in project window.  

 

**Details described in the following documentation 

 

Documentation 

1. Data comparison in a single column or row 

In the Data Comparison table, it is now possible to have the program group all the results 

in a single column rather than spread them across the values provided by a specific 

column in the results table. To do so pick “Single column” for the With field: 
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This will provide you with fields as follows: 

 
Fill in a title for this comparison and a value that will be used as a column header.  

Important note: Click “Switch axes” to present the data in a column. The ntatural 

direction will be a single row. 

 

Example: 

 
 

Results in this table (partial view): 
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2. Group  column 

Selecting a column and then picking “Results->Group column” provides a hierarchical 

view of your data, as the name suggests, grouped by the values in that column. This also 

provides for  single sub-level hierarchical reporting using “File->Export data” 

 

Thus, this data: 

 
Grouped by “aBigCol” (indicated by the fact that it is that column which is selected) 

would provide an outline view like this (I’ve opened the first two outline-triangles): 
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The _code column reveals the value grouped on (not shown above) and the _data column 

provides a count of the records found for each value.  

 

Remember that export data provides a wide variety of options on exporting outlines, 

when the outline view is showing (lower case “o” in the upper left corner of the results 

window. 

 

Remember to click the “o” to return to table view (the o will turn into a “t”). 

 

3. Analysis of temporary columns 

 

Selecting a temporary column and picking “Results->Temporary column->Analyze 

selected rows...” provides a number of numerical analyses of the data in the selected 

temporary column.  

 

Make sure you are working on a copy of the column as the contents will be replaced 

by the results of the analyses described below. This is made easier in this version  with 

the new “Results->Temporary column->Add copy of the current column...” command, 

which asks for a column header and then generates a new temporary column with a copy 

of the currently selected column. 

 

Three analyses are available to you 

 

A. Length: 

 



 5 

 
This simply replaces the current column with a measure of the length of the text in each 

row in the currently selected column. 

 

B. Count of expression 

 
Using regular expressions (filled into the Expression box), this choice will replace the 

current column with the number of matches of that expression in each row in the current 

column. This is useful for getting a word count (Expression = “[a-zA-Z]+”) for instance. 

 

C. Average length of expression 

 
Here the program replaces the column contents with a  calculation of the average length 

of patterns. Users can indicate if they wish to examine the whole expression found 

(Match=0) or a substring of that expression (Match > 0). Refer to a regular expression 

tutorial to learn about substrings. To find the average word length we would fill in the 

expression “[A-Za-z]+” and keep Match at 0. 
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TAMS Analyzer 3.41b4 Release Notes 

 

Leopard compatibility!!! 

 

• New features 

1. Enumerate contents of a temporary column both breaking (resetting) on a new 

value or continuing to sequence subsequent matching entries.** 

2. Rename temporary columns 

3. The separator for copy column to temporary column now interprets escape 

characters \t, \n and \r 

4. Remove tag from temporary column now actually available on the Temporary 

column menu  

 

• Bug fixes 

1. Fixed bug for create new file with blank name 

2. _doc can now be used to generate a temporary column in Add column and 

copy. 

3. Links in data comparison now work with Leopard, Safari 3, and 10.4.11 

(which installs safari 3). 

 

**Details described in the following documentation 

 

Documentation 

1. Enumeration of values 

 

TAMS Analyzer now can take a temporary column and replace it with an enumeration of 

its values. Consider this example: 

 
Originally, this consisted of three identical columns. Notice that there is an extra “X” in 

the last row, that’s orphaned from the two X’s at the top. TAMS offers two ways to count 

this data. The first way keeps counting when it finds matching values, whether those 

values are contiguous with others or not. That’s the “No reset” column above. The final 

X is numbered “3” since it is the 3
rd

 X that TAMS finds in the column.  
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The second way that TAMS enumerates restarts the count every time the value in the 

column shifts. In this case, the final X is counted as “1” since the immediately previous 

value is a “Y”. Contiguous values are enumerated starting with  each time a patch of  

such contiguous values are encountered by TAMS as it works its way down the list.  

 

Both enumeration options are found on the “Results->Temporary column” submenu. 



TAMS Analyzer 3.42b6 release notes 

 

New Features 

- Item count in data comparison chart 

- Sub code temporary column 

- Fast access buttons for data and results files on Files tab 

- Updated regex engine  

- Updated mysql software (Multiuser version only) 

- Small interface improvements 

- Builds with help (manual and tutorial) built into the program 

 

Notes: 

1. Item count in data comparison chart. 

 

Some time ago TAMS lost the ability to generate raw counts like this in data comparison 

reports: 

 
 

This version restores this capability. To put counts in your report pick “Count only” from 

pull down menu in the data elements box: 

 
2. Subcode temporary column 

 

I have added the ability to create a column of “subcodes.” Subcodes simply means a part of a 

code. Given code a>b>c subcodes might include a>b or b>c or a or b or c. Previously this 



could be done with tricky regex coding, I’ve just made it easy. Pick “Temporary column-

>Add column with subcode...” That will give you this dialogue: 

 
Fill in a unique name for the column. Then put in the start and end levels you want: for 

a>b>c putting in a start tag level of 1 and end tag level of 2 would give you a>b. Putting in 1 

and 1 respectively would give you a. Putting in 3 and 9999 (or some other large number) will 

give you c for this case but for a>b>c>d would give you c>d.  

 

You can also use negative numbers to put in the end of codes. so putting in -1 -1 would give 

you the lowest level of code for each row. -1 and -2 would give the last 2 for each row.  

 

3. Fast access buttons for data and results files. 

 

The biggest issue I have to deal with supporting TAMS is people opening their results files 

from the desktop rather than from within TAMS. Right now getting to the results files is 

hidden in a little pull down menu on the Files tab. To make things more transparent I’ve 

added two buttons which give you instant access to your Results and data files: 

 

 
 



TAMS Analyzer 3.43b3 Release Notes 

 

This release adds powerful control over organizing and formatting dates. It also fixes two 

bugs: data comparison tables sometimes didn’t print the both total columns when “include 

total” was checked; saved result windows didn’t rebuild the named code set menu right 

away. Finally it includes a normal search/replace for temporary columns. The old regular 

expression transformation is still there, just click the regex check box, other wise the menu 

item formerly called Results->Temporary column->Transform column—and now called 

Results->Temporary column->Find/Replace/Transform column—will do a straight forward 

find/replace through the temporary column that’s selected. Note, that even in regular find and 

replace you can use \n and \r for return characteres and \t for tabs. Finally, I’ve worked on 

updating the documentation. I’ve also broken up the user guide into separate documents for 

the purposes of the help function. There are two new sections in the updated documentation: 

one on temporary columns, the other on data comparison tables. 

 

New features: 

- In result windows, each column can have its own date/time format for sorting and 

grouping purposes. 

- Date formats can be set automatically through the {!dateformat} metatag. 

- Dates can be transformed and grouped by day, month, and year. 

- Find/Replace in temporary data columns 

 

Bug fixes 

- Named sets menu wasn’t updated when a saved result file was loaded 

- Data comparison tables didn’t print out both row and column totals when “include 

totals” was checked. 

- Improvements to sorting by date/time 

- For date format dialog, the field for specifying the date format is hidden unless other 

is specified from the menu. 

 

Other 

- Updated User guide and Tutorials 

 

Documentation 

1. Setting the date format 

 

Researchers can now set a date format for a specific variable. This is done through a 

metatag {!dateformat} which identifies a variable (e.g., a context variable), and the string 

format for the date. For setting string formats see  

 
http://developer.apple.com/documentation/Cocoa/Conceptual/DataFormatting/Articles/dfDateFormatterSyntax.html 

 

Typical use will be setting date formats after declaring the variable: 
{!context publicationDate}  
{!dateformat publicationDate="%m/%d/%Y"}  

 



Note that these must be straight quotes. This format says that the date is formatted as 

mm/dd/yyyy. You are telling TA what dates look like for the purposes of sorting the 

column associated with the context variable publicationDate and for grouping which will 

be explained below. 

Alternatively, researchers can set the format associated with a date in the results window. 

If no column is selected, picking "Results->Sort options->Date format..." will set the 

default format for dates (very useful). If a column is selected, the date format will apply 

to that column and any columns created through "Results->Temporary column->Add 

copy of current column..." If you do not specify a format, the column will be sorted using 

the default date value. 

 

2. Grouping and transforming dates 

First, this only applies to temporary columns. The changes are made directly to the 

column that is selected. 

 

Transforming these dates is primarily a way to view your data by date/year/month range 

for Data comparison reports. It also can be  a way to transform date formats (changing 

mm/dd/yyyy to yyyy-mm-dd, for instance) 

 

Select a column containing date data. As of this release this will group and transform 

dates by year, day, and month. At some point in the future, similar support for time may 

be added. 

 

Make sure that you have specified the current format for the date strings using "Results-

>Sort options->Date format..." (see note 1 above). 

 

Pick "Results->Temporary column->Group dates..." 

 

If you have specified your date format correctly, you should see the following dialog: 

 



1. This will show the 
earliest date in the 
selected column. 
You can alter this 
date to control how 
date groups are 
defined (e.g., forcing 
the groups to start 
on a sunday or a 
later date)

2. The ? button here will show the day of the 
week represented by this earliest date. Useful 
for adjusting for ranges of dates

3. You can transform this column into 
one that just specifies month, year, or 
ranges of days, months or years. Pick 
the scale you want from here. It will 
change the contents of the output 
format menu.

4. Indicate what range you want 
to group things within. If you 
want to group by week, you 
will pick Days from menu 3, and 
indicate “7” in this field. If you 
want to group by quarter, you 
will pick month from menu 3 
and 3 (3 months in a quarter) 
here. If you want to group by 
decade, pick years from menu 
3 and fill in 10 here.

5. Pick how you want 
dates formatted after 
they have been 
grouped/transformed. 
This will also set a new 
date format for the 
column. Notice that the 
menu shows both the 
format string and an 
example of how it will 
look.

6. Menu 5 just puts the 
format string into this 
field. You can then 
modify it, if you like. 
Clicking the ? button will 
show you how your 
modifications will look. 
This field is then used for 
the formatting of the 
modified dates, and as 
the date format for this 
column.  



Examples:  

1. Grouping data by week 

 

A. Make a temporary column of your dates called grpByWeek; make sure the date 

format is set for this column. E.g. your initial data may look like this: 

 
 

B. Pick "Results->Temporary column->Group dates" 

C. In the dialogue, adjust the start date to a Sunday (use the ? button to check the day of 

the week. Pick Days from menu 3 and fill in 7 for "Number to group." 

D. Pick, just as an example,  "%Y-%m-%d" from menu 5, and click "Ok." The data 

should now look like: 

 

 
Now we can see what codes are used by week through a data comparison table: 

 
Similar procedures could be used for grouping by quarter or by decade or other range of 

dates. 



2. Transforming dates 

To change dates rather than group them make sure you have set the date format for your 

data as it now stands, pick "Results->Temporary column->Group dates..."  and then 

simply 

A. Pick day from menu 3  

B. Set the "Number to group" field to "1"  

C. Pick the new format for your dates from menu 5. 
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TAMS Analyzer 3.44b4 Release Notes 

 

This release adds a variety of real usability improvements to data comparison tables. These 

include: 

 

1. You now have the ability to set your own titles/captions for a data comparison table 

2. Subtotals and totals are now hot linked to the data 

3. The default selection technique for hot linking in reports is now a new mode called 

“smart highlight/selection” which works as follows: if you click on an item linked to 

a single row of data, the program will try to highlight it in the current selection; in all 

other cases it will select the related records. 

4. “Do not count duplicates” is a check option/item, so it can be used with all types of 

data comparison tables including “count only” See documentation below 

5. Clicking on a hot linked item with “Do not count duplicates” checked will select all 

the relevant records: it’s as though you had run your report with “Group” picked from 

the Data Elements menu. 

6. The comparison data dialogue will optionally (on by default) restore the current 

selection, which means you can click on different data items, and then generate 

another report. This is zeroe’d out if you pull up data comparison report from the 

Report menu or the icon for data comparison reports. The selection is retained if you 

use the Window menu or click on the data comparison dialogue. 

7. Data comparison table button is now part of the Results window’s default tool bar 

button set. Note that this will not effect current users, only new users. Current users 

will need to go to “Configure tool bar” on the Windows menu to change their tool 

bars. 

8. Small interface tweaks to the Data Comparison Dialogue 

 

Documentation 

Do not count duplicates check box 

 

On the data comparison dialogue, in the Data elements box, the old menu option “Group 

do not count duplicates” has been moved to a check box to the right of the menu. Include 

total has also been moved to the right. 

 

Checking “Don’t count duplicates” primarily effects the totals if “Include total” is 

checked. For “Do not group”, “Group”, and “Group and subcount” menu items, that is 

the only thing effected by the “Don’t count duplicates” option. If you don’t “include 

total” column/rows, not counting duplicates does nothing (visible). 

 



 2 

To clarify the effect consider the following phony data: 

 

 

If you were to use the data comparison table to look at the contents of aBigCol grouped 

by code You would get the following (I’m comparing _code to a single column), 

including total but leaving the “Do not count duplicates” box unchecked: 

 

So for code “d” there are 6 different rows, and we see the values of each, and the Total is 

6: the number of rows that d has regardless of the value of aBigCol. 

 

Now this is the same report with the “Do not count duplicates” checked: 
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Notice that now the for code “d” is 3. That’s because there are 3 different values for 

aBigCol in the row (bisquits, dogs, rats: 3 different values). Clicking the 3 in the total 

column will still pull up all 6 records, but it only counts each different value one time.  

 

The one menu option that is really effected by the new check box is “Count only” since it 

will apply this logic to each intersection of the data comparison table (and then total those 

in the Total column). In other words, picking “Count only” from the menu and not 

selecting “Do not count duplicates” produces the following in our example: 

 

 

But picking “Do not count duplicates” ignores the redunancy in values (“dog” will only 

be counted once: 

 

Real world example 

In looking at the discourse of the anthrax attacks, the data is all grouped in articles. Often 

I’m not interested in how many occurrences there are of a code like 
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fear>about>economy, for instance, but how many articles talk about 

fear>about>economy. One article may talk about it only one time, or dozens of times, I 

don’t care, since the article is a more organic unit than the actual coded instance. 

Previously I could accomplish this by selecting the rows that contained 

“fear>about>economy”, sorting them by article, and then collapsing up or down to get rid 

of the redundancy, and then doing a data comparison table.  Now all I need to do is select 

for “fear>about>economy” and do a data comparison table (_code by “Single column” or 

my preference is to see it by city, and article selected in the data elements field table) and 

make sure “Do not count duplicates” is checked. 

 

The Data comparison options I would use: 

 

You can see I’ve highlighted codes in the “Compare box”, “city” in the “With field” box. 

I’m counting “cityArt” (Article number with city name attached—the column which 

uniquely identifies the article each coded passage came from) without duplicates: 

 

Voila! There are 6 such articles; 3 from each city. Clicking on any of these numbers will 

show me all the relevant rows. How many raw rows are there? I’d uncheck the “Do not 

count duplicates” and find there are 7: 
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)6<,%166PA',P%&'A+4%',+%<&9N<+X%6,%!"#$%:9((%,+@+,%)6<%6&()%76%7B+%@9,47%166PA',P%

:97B%7B'7%&'A+.%

 

W&%)6<,%A+A6X%)6<%:9((%:'&7%76%'??%'%(9&P%76%7B'7%166PA',P.%!B+%(9&P%94%'%A+7'7'C%:97B%

7B+%@6((6:9&C%47,<>7<,+%

{!goto file="myfile.rtf" bookmark="My first bookmark"} 

 

!B+%@9(+%B'4%76%B'V+%7B+%V'(<+%6@%7B+%@<((%'&?%<&9N<+%&'A+%6@%7B+%@9(+%>6&7'9&9&C%7B+%

166PA',PX%7B+%166PA',P%B'4%76%B'V+%7B+%V'(<+%6@%7B+%<&9N<+%&'A+%6@%7B+%166PA',P%9&%

7B'7%@9(+.%

 

!6%<4+%7B+%(9&PX%49AF()%>(9>P%'&):B+,+%9&%7B+%LC676%A+7'7'CX%'&?%F9>P%OZ6?9&C=

[3+@+,+&>+4=[\6%76%,+@+,+&>+O.%%!"%:9((%6F+&%7B+%@9(+%'&?%A6V+%)6<%76%7B+%166PA',P.%

 

3'7B+,%7B'&%7)F9&C%9&%7B+%LC676%)6<,4+(@X%97]4%+'49+,%76%B'V+%!"%?6%97%@6,%)6<.%\6%76%7B+%

166PA',P%)6<%',+%9&7+,+47+?%9&%'&?%>(9>P%9&49?+%6@%97.%!B+&%F9>P%OZ6?9&C=[3+@+,+&>+4=

[3+A+A1+,%,+@+,+&>+O.%!"%:9((%F<7%76C+7B+,%'%LC676%@6,%)6<%'&?%F<7%97%6&%'%4F+>9'(%

>(9F16',?.%!B+&%C6%76%:B+,+%)6<%:'&7%7B+%(9&PX%'&?%F9>P%OZ6?9&C=[3+@+,+&>+4=[W&4+,7%

,+@+,+&>+%(9&PO%'&?%'&%'FF,6F,9'7+%LC676%:9((%1+%9&4+,7+?%'7%7B+%><,46,%F649796&.%%

 

%

"((%7B,++%,+@+,+&>+%@<&>796&4%',+%'V'9('1(+%'4%766(1',%1<776&4.%!B+%OC676%,+@+,+&>+O%94%

F',79><(',()%<4+@<(%@6,%U<AF9&C%:97B%'%>(9>P%76%7B+%L166PA',P%(6>'796&.%!6%F+,A'&+&7()%

'??%7B+4+%@<&>796&4%76%)6<,%766(%1',%)6<%:9((%&++?%76%<4+%7B+%L1<776&%A+7'7'C%@6((6:+?%

1)%7B+%@6((6:9&CX%9&%46A+%6,?+,X%>A?YYC6!63+@+,+&>+X%>A?YY,+A+A1+,3+@+,+&>+X%6,%

>A?YY9&4+,73+@+,+&>+^9&P%%9&%)6<,%9&97%@9(+X%6,%'7%7B+%76F%6@%?6><A+&7%@9(+.%
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%

!"%-./01_%9&7,6?<>+4%'%&+:%:')%76%>6?+%4+>796&4%6@%7+K7.%!B94%94%<4+@<(%@6,%7B+%@6((6:9&C%

497<'796&4Y%

%



0. !'CC9&C%A+A64.%`@7+&%9&%'%A+A6X%)6<%:'&7%76%U<47%F,6V9?+%'%(947%6@%7'C4%7B'7%>'&%

'>7%'4%>6?+4%@6,%7B+%+&79,+%A+A6.%%

H. Z6?9&C%B9CB()%47,<>7<,+?%?'7'.%`@7+&%F,6U+>74%?6&]7%9&V6(V+%>6?9&C%F6,796&4%6@%'%

7+K7%1<7%+&79,+%61U+>74.%!B9&P%6@%>,+'79&C%>',?4%:97B%97+A4%)6<%',+%>6?9&C.%a'>B%

>',?%,+F,+4+&74%6&+%46A+7B9&CX%'&?%)6<%:'&7%76%>6?+%7B+%>',?4X%&67%7B+%F',74%6@%

7B+%46A+7B9&C%6&%7B+%>',?4.%"C'9&X%)6<%',+%1'49>'(()%7'CC9&C%7B+%>',?4.%

%

!6%'>>6AF(94B%7B94%7:6%&+:%A+7'7'C4%',+%'??+?%76%!"]4%V6>'1<(',).%!B+%49AF(+%V+,496&%

94%L4+7>6?+.%!B+%@6,A'7%94%%

%
% {!setcode code1, code2, code3} 
 

W7%:9((%>6?+%7B+%+&79,+%4+>796&%47',79&C%'7%7B+%F69&7%6@%7B+%7'C%:97B%>6?+0X%>6?+HX%'&?%

>6?+-X%:B9>B%4B6<(?%,-.%1+%'%>6&7+K7%>6?+.%!B+4+%:9((%1+%?'7'%>6?+4%'FF(9+?%76%7B+%

4+>796&4.%;6,%+K'AF(+X%'%A+A6%@9(+%A9CB7%(66P%(9P+%7B+%@6((6:9&CY%

%
{!context date} 
{!last date} 
 
{date}1/12/2009{/date} 
{!setcode a, b, c} 
 
This is the text of my first memo. 
 
{date}2/1/2009{/date} 
{!setcode b, d} 
 
This is the text of my second memo. 
 

!B94%94%1'49>'(()%7B+%4'A+%'4%%

%
{!context date} 
{!last date} 
 
{date}1/12/2009{/date} 
{a}{b}{c} 
 
This is the text of my first memo. 
{/a}{/b}{/c} 
{date}2/1/2009{/date} 
{b}{d} 
 
This is the text of my second memo. 
{/b}{/d} 

%

`1V96<4()X%7B+%@9,47%94%+'49+,%76%,+'?X%'&?%4+,V+4%'4%'%49AF(+%:')%76%'FF()%'%(947%6@%7'C4%76%

)6<,%A+A64X%'&?%9&>(<?+%7B+A%9&%)6<,%,+4<(74%:9&?6:4.%%



%

L4+7>6?+%7'P+4%974%B6,9*6&%D7B+%F69&7%'7%:B9>B%7B+%>6?+4%+KF9,+E%@,6A%7B+%4'A+%B6,9*6&%

'4%L('47%'&?%L9&&+,.%J)%?+@'<(7%97%94%L+&?4+>796&4X%1<7%97%>'&%1+%>B'&C+?%7B,6<CB%7B+%

LV9,7<'(+&?%6,%LV9,7<'(+&?4+>796&.%!B+,+%94%&6%O>6?+,O%'??+?%76%7B+4+%>6?+4.%

%

!6%'((6:%A6,+%>6&7,6(X%7B+,+%94%'%4+>6&?%7'C%L4+7>6?+9&@6%:B9>B%7'P+4%7B+%@6,AY%

%
{!setcodeinfo codes="code1, code2, code3" 
coder="myinitals" horizon="end or endsection"} 

%

b+,+%)6<%>'&%>6&7,6(%167B%7B+%>6?+,]4%9&979'(4%D:B9>B%:9((%'((6:%)6<%76%B'V+%A<(79F(+%

F+6F(+%7'C%97+A4E%'&?%4+7%7B+%+&?%F69&7%@6,%7B+%7'C4%D+97B+,%+&?%6,%+&?4+>796&X%&67%167BLE%

%

!B+,+%',+%(9A974%76%>6?9&C%7B94%:').%;9,47X%'??>6?+X%,+>6?+X%'&?%'((%7B+%67B+,%@<&>796&4%9&%

7B+%3+4<(74=[3+>6?+%A+&<%:9((%&67%:6,P.%"(46X%4+779&C%>6?+4%9&%7'C4%6F+&4%<F%'((%46,74%6@%

F644919(979+4%@6,%A')B+AX%+4F+>9'(()%&+47+?%>6?+4.%!B+,+]4%&6%:')%6@%B'V9&C%!"%F,+=

>B+>P%@6,%&+479&C%9&%7B94%>'4+X%1<7%)6<%:9((%C+7%(674%6@%+,,6,%A+44'C+4%9@%7B+%>6?+4%'&?%

B6,9*6&4%('&?%<F%>6&@(9>79&CL%!B+,+]4%'(46%7B+%V+,)%?'&C+,6<4%F644919(97)%6@%<49&C%'%

>6&7+K7%>6?+%9&%6&+%6@%7B+%7'C4%:B9>B%:9((%(+'?%76%'7%1+47%47,'&C+%1+B'V96,%'&?%'7%:6,47%

>,'4B+4LLL%W]V+%7,9+?%76%'&79>9F'7+%F,61(+A4%'4%1+47%W%>'&X%1<7%A)%+KF+,9+&>+%94%7B'7%

7B+,+]4%A<>B%W%49AF()%>'&]7.%

%

!6%'44947%)6<%9&%'??9&C%>6?+4%76%)6<,%L4+7>6?+%7'CX%)6<%>'&%&6:%?,'C%'&?%?,6F%>6?+4%

@,6A%7B+%>6?+%(947%9&%?6><A+&7%:9&?6:4%'&?%7B+%&'A+%6@%7B+%>6?+%:9((%1+%9&4+,7+?%9&%%

7B+%7+K7.%!B+,+%94%'(46%'%A+&<%97+A%:B9>B%?6+4%7B94Y%Z6?9&C=[W&4+,7%>6?+%&'A+X%:B9>B%

:9((%7'P+%:B'7+V+,%>6?+%94%4+(+>7+?%'&?%9&4+,7%97%'7%7B+%><,46,.%!B94%:')%)6<%>'&%<4+%

)6<,%>6?+%(947%'4%7B+%46<,>+%6@%)6<,%7'C4.%

%

." /&+01)+-#2)3&4#

%

$+V+,'(%F+6F(+%B'V+%'4P+?%@6,%'%,+&'A+%@<&>796&X%'&?%7B94%,+(+'4+%B'4%'7%(+'47%'%@9,47%

'77+AF7%'7%6&+.%J+>'<4+%!"%A9>,6A'&'C+4%7B9&C4%+V+&%7B94%49AF(+%@<&>796&%>'&%C+7%

7,9>P).%J<7%7B+%6F+,'796&%94%49AF(+%+&6<CBY%4+(+>7%6&+%@9(+%@,6A%)6<,%@9(+%(947%'&?%F9>P%

c,6U+>7=[3+&'A+%@9(+.%

%

!B+,+%',+%(9A974%76%:B'7%>B'&C+4%:B+&%)6<%,+&'A+%'%@9(+X%'&?%,+&'A9&C%94&]7%,+'(()%

,+>6AA+&?+?.%b+,+%',+%'%4A'((%&<A1+,%6@%7B9&C4%76%>6&49?+,Y%

%

0. T6<%>'&]7%,+&'A+%'&)%6F+&%@9(+4d%!"%:9((%C9V+%)6<%'%:',&9&C%

H. 3+&'A9&C%:9((%&67%>B'&C+%'&)%7'C4%D(9P+%L&'A+E%9&%7B+%@9(+d%46%)6<,%?'7'%:9((%1+%

6<7%6@%4)&>B%9&%7B'7%4+&4+%

-. W&%,+4<(74%:9&?6:4X%7B+%M?6>%>6(<A&%:9((%>B'&C+X%1<7%;9(+5'A+%D:B9>B%94%>,+'7+?%

@,6A%7B+%L&'A+%7'CE%:9((%&67.%%

_. W&%,+4<(74%:9&?6:4X%9@%)6<%C,6<F%7B+%M?6>%>6(<A&X%7B+%(+V+(%0%B+'?9&C4%:6&7%

>B'&C+%:B+&%)6<%,+&'A+%7B+%@9(+X%1<7%7B+%(+V+(%H%M?6>%>6(<A&%:9((%F,6F+,()%

<F?'7+.%



%

e6&]7%4')%W%?9?&]7%:',&%)6<.%!"%>,+'7+4%'%F,+77)%+&7'&C(+?%:+1.%J<7%)6<%'4P+?%@6,%97d%)6<%

C67%97L%

%

/. 5*,&#4&(#(06%

%

!B+%7'1%7B'7%<4+?%76%1+%>'((+?%OZ6?+%$+74O%94%&6:%U<47%>'((+?%O$+74O%'&?%'((6:4%)6<%76%

'?U<47%167B%@9(+%'&?%>6?+%4+74.%!6%F9>P%:B+7B+,%)6<%:'&7%76%:6,P%:97B%>6?+%6,%@9(+%4+74X%

>(9>P%7B+%7'1%6&%7B+%(+@7%49?+%6@%7B+%:9&?6:%DA',P+?%@9(+4%6,%>6?+4E.%!B+%6F+,'796&4%',+%

V+,)%49A9(',%76%<49&C%7B+%@9(+%7'1%76%F<7%76C+7B+,%'%4+',>B%(947.%!B+%1'49>%6F+,'796&%

9&V6(V+4%@6((6:9&C%7B+%47+F4%4B6:&%9&%7B94%?9'C,'A.%

%

%
%

J+9&C%'1(+%76%(6'?%7B+%>6?+%4+7%?9,+>7()%@,6A%7B94%F'&+%94%6&+%&+:%@+'7<,+%6@%7B+%F'&+.%

!B+,+%:6&]7%1+%A<>B%+V9?+&>+%6@%97%9&%7B94%:9&?6:%DU<47%'%>B'&C+%9&%7B+%&'A+%1)%7B+%

O">79V+%>6?+%4+7O%49C&d%1('&P%A+'&4%'((%>6?+4%',+%4B6:9&CEX%1<7%?6><A+&7%:9&?6:4%:9((%

6&()%4B6:%7B+%C9V+&%>6?+%4+7%`3%7B+%;9(+4%7'1%:9((%6&()%4B6:%7B+%4+(+>7+?%@9(+%4+7.%

%

W&%'??9796&%76%U<47%F9>P9&C%7B+%&'A+4%:97B%7B+%A6<4+X%)6<%>'&%<4+%7B+%4+(+>7%@9+(?%'&?%

1<776&4X%U<47%(9P+%1+@6,+.%%

%

!6%,+&'A+%'%>6?+f@9(+%4+7%?6<1(+=>(9>P%7B+%&'A+%@,6A%7B+%Z6?+%4+74%7'1(+%'&?%?9,+>7()%

>B'&C+%7B+%&'A+.%

%

1) Select the codes/
files you want in the 
set. Use the shift key 

and command 
(apple) key to extend 

your selection.

2) Add the 
codes by 

pressing the 
“Add” button 

and then adjust 
using these 

other buttons.

3) The selected 
codes will then 
be listed here.

4) Fill in the new 
name for your 

file/code set 
here.

5) Then click 
“Add” to make it 

a code set.

6) The new code/file set name 
will be listed here.

7) The code set will not be 
active. To make it the 

working list of codes in 
documents, select the name 

from the “Code sets” table 
and click “Load”

8) After 
you make it 

active, it’s name 
should appear 

here.



5+K7%76%7B+%&'A+%6@%7B+%'>79V+%>6?+f@9(+%4+7%7B+,+%',+%7:6%1<776&4.%!B+%1<776&%('1+(+?%

OgO%:9((%A6V+%1'>P%76%7B+%('47%'>79V+%>6?+%4+7.%W@%7B+%>6?+%4+7%&'A+%94%1('&PX%97%A+'&4%'((%

>6?+4%',+%'>79V+%D9.+.X%)6<,%?6><A+&7%:9&?6:%:9((%4B6:%'((%)6<,%>6?+4d%7B+%@9(+%7'1%:9((%

4B6:%'((%7B+%@9(+4E.%!6%?9,+>7()%(6'?%'((%7B+%>6?+4%>(9>P%7B+%h%1<776&.%
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(

!"#$%"&'()"*$

• !*1&('&)'(#$1(234&('&)'(5#$($*6(#7)*8791#)&()":*7%"(#(9:&2&:&$5&(3)&;(<=&&(

>*57;&$)#)3*$(?&4*6@(

• A*)(43')(/7))*$(2*:(1&23$&(5*1&'(

• B;9*:)(C'&)5*1&(<#$1(C'&)5*1&3$2*@(3$)*()"&(5*1&(135)3*$#:D(63)"(#7)*;#)35("*)(

'&)(5:&#)3*$(#$1(&13)3$%(*2(1&23$3)3*$'(

• E#:#%:#9"((#$1(=&$)&$5&('&#:5"&'(<=&&(>*57;&$)#)3*$(?&4*6(

• F1G#$5&1(?**4&#$(*9)3*$'(3$(9#:#%:#9"(#$1('&$)&$5&('&#:5"(

• HI#5)(5#'&(;#)5"(3$(9#:#%:#9"(#$1('&$)&$5&('&#:5"(

• F/343)D()*(;*132D(5"#:#5)&:'(7'&1(#'()"&(5:3)&:3#(2*:('&$)&$5&(&$1',(

(

+,'")%&-"$-.&,/"*$

• J#:$3$%(2*:(1&4&)&(5*1&(

• B$)&:2#5&(;#1&(9#:#44&4(2*:(/*)"()"&(43))4&(#$1(/3%(5*1&(1&23$3)3*$()#/'(#$1(

13#4*%7&'(

• K&$#;&(234&($*6("#'(L&D(&M73G#4&$)(

• K&$#;&(/7))*$(#11&1()*(234&(#$1(5*1&('&)'(

• >&4&)3$%(#('3$%4&(234&($*6("#'(#(6#:$3$%(13#4*%7&(

• >&2(/7))*$(:&;*G&1(2:*;(234&('&)'('7/)#/(

• >&2(/7))*$(/&))&:(94#5&1(3$(5*1&('&)'('7/)#/(

(

0(/$%12"*$

• ?7%(23I(2*:(5*1&("3')*:DN()"*7%"(2*:('3$%4&(7'&:(1*&'$O)(1*(#$D)"3$%(

• ?7%(23I(3$(9:*P&5),"*)5*1&43')(:*7)3$&N(5#7'&1(2#)#4(5:#'"(32()"&(5*1&('&)(;&$7(*$(

5*1&()#/(6#'(5435L&1(

• >*57;&$)(63$1*6('5:*44(9:*/4&;(23I&1(<:3%")('5:*44(/#:(6*741(%:#17#44D(G#$3'"(

*22(*2(63$1*6@(

• ?7%(23I(2*:(C;&13#(6"&$(;&13#(234&(3'$O)()"&:&(

• ?7%(23I(2*:(1&4&)&(5*1&($*)(:&;*G3$%(5*1&(2:*;(5*1&'&)'(

• Q*:(;74)37'&:(/7341N(5"&5L'("*41&:(/&2*:&(:&$#;3$%(

(

(
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(

R6*($&6('&#:5"&'(#:&(#11&1()*()"&('&#:5"(;&$7'(<)"&(*$&(*$()"&(9:*P&5)(63$1*6(#$1(

)"&(*$&(*$()"&(1*57;&$)(63$1*6@S(=&$)&$5&(#$1(E#:#%:#9",(T*)35&()"#)()"&:&(3'($*6(#(

13G31&:('&9#:#)3$%(5*1&('&#:5"&'(2:*;(5"#:#5)&:(<#L#()&I)@('&#:5"&',((

(

(
U9)3*$'(*$(#('&$)&$5&(*:(9#:#%:#9"('&#:5"(

(

=&$)&$5&(#$1(9#:#%:#9"('&#:5"3$%S(B$(/#'35(;*1&(<3,&,N(63)"()"&(?#'35(/*I(5"&5L&1@((D*7(

5#$(&$)&:(#(6*:1(*:(&I9:&''3*$(#$1(RF(6344(:&)7:$(#44('&$)&$5&'(*:(9#:#%:#9"'()"#)(

5*$)#3$()"#)(&I9:&''3*$,((?&2*:&()"3'(G&:'3*$(7'&:'(6*741("#G&()*(5*$'):75)(5*;94&I(

:&%74#:(&I9:&''3*$('&#:5"&'()*(#55*;943'"()"3'()#'L,(R"3'(&I9:&''3*$(5#$(3$5471&('9#5&'N(

97$5)7#)3*$N(&)5,(B$(2#5)(3)(6344($&&1()*(;#)5"(&I#5)4D(6"#)(D*7()D9&1(<)"*7%"()"&:&(3'(#(

5#'&('&$'3)3G3)D(*9)3*$@V(32(D*7()D9&(#('3$%4&('9#5&(/&)6&&$(6*:1'N(3)(6344($*)(;#)5"()6*(

'9#5&',((

(

B$()"&('&5*$1(;*1&(<?#'35(/*I(7$5"&5L&1@():&#)'(6"#)(D*7()D9&(3$(#'(#(/**4&#$(

&I9:&''3*$N(;&#$3$%(D*7(5#$('#D(23$1(#44('&$)&$5&'(63)"('43;&(/7)($*)("#3:/#44,(F5)7#44D(
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TAMS Analyzer 3.53b4 Release Notes 

 

New Features 

1. Full Boolean searches for simple, non-simple and section searches. 

2. Open files by double clicking search list (just like the files list) 

3. Gather citations (with toolbar button) 

4. Code Count report now counts codes  in setcontext, setcode, setrepeat, universal and 

var metatags (only counted if value is set). NOTE: co-coding is not changed and will 

not report on setcode, etc. 

 

Bug fixes 

1. Window boundaries better placed relative to tabview in project window 

2. Infinite loop bug for !setcode fixed 

3. Several memory leaks plugged in the tams character engine (the parser at the heart of 

searching). 

4. Memory leaks plugged in the sentence/paragraph Boolean parser 

5. Find record now works with outline view created by grouping column in results 

window; double clicking a row (or single clicking the row followed by clicking the 

Find Record button) in the outline will take you to the associated document and 

location. 

6. Updated documentation; a-v how to and tool bar how to updated and added to on line 

help and pdf help. Qual. Anal. for Beginners updated. 

 

Documentation 

 

Full Boolean Searches For Codes 

 

Now users can use AND, OR, NOT and parentheses (to force priority) for any of the code 

searches. The syntax follows the traditional tams syntax: ! = NOT , = OR  + = AND. 

 

So to find all codes other than mycode search for !mycode; to search for sections with both 

thiscode and thatcode search for thiscode+thatcode. You can still use modifiers like “>” 

which searches for a subcode, or “*” which does a substring search or “ ‘ “ which does an 

exact search.  

 

Since simple searches apply your search criteria to each code it finds it makes no sense to 

ask for thiscode+thatcode in a simple search (you probably want a non-simple search which 

asks about stretches of text rather than about each individual code). There are some AND 

searches that make sense however for simple searches. For example you might want to find 

all codes and their text that have “>some” and “>level” as parts of their code. Or you might 

want to search for codes that have “>some” (meaning “some” appears as some level of the 

code) and the same code has a substring “sub” you would then search for  

>some+*sub 

Only passages coded with things like submarine>problems>some will be returned. The code 

has to meet the criteria of each part of the AND search. Like I said, it’s pretty unusual to use 

AND in a simple search, and most of the time the researcher really wants a non-simple 



search (passages of text coded with thiscode and thatcode). TAMS will warn you that AND 

(+) in a simple search is probably wrong, but if you are certain you can click “YES” to 

proceed.  

 

Gather citations 

This adds the final feature for the reference functions used for memoing. Earlier releases 

added the ability to link to bookmarks and files by using the !goto metatag. This release 

allows you to find all the citations to a given document (which documents have “!goto’s” 

pointing to this file or bookmark).   

 

Open the document for which you wish to find citations and pick Coding->References->Find 

citations 

 

 
Fig. 1: The new “Find citations” command 

 

If you want to find citations to a specific bookmark, simply click inside of the bookmark and 

pick the same “Coding->References->Find citations” menu command! 

 

What you will get is a window with a list of documents referencing the document/bookmark 

of interest: 



 
Fig. 2: Citation list 

 

At the top is the document and bookmark (if appropriate) that you want to find citations for. 

If a document has more than one citation (i.e., !goto tag) to the current document/bookmark , 

it’s name will be listed multiple times (see Fig. 2 where gamma and sample are listed 

multiple times because each has multiple !gotos pointing at alpha). Double clicking a row (or 

clicking once followed by the “Go to…” button) will open the listed document and move you 

to the !goto metatag that cites the current bookmark/document. Cancel dismisses the window. 

 

Using the Find Citation command allows you to find any memos that refer to the current 

document. If executed from the workbench, the list contains all references in the project (see 

fig. 2) 

 

The find Citation command is also available a tool bar button. To add it permanently to your 

toolbar use the !button command. The key word for find citation is cmd::citations.: 

 

{!button cmd::citations} 

 

Placed in your init file it will add a Find citations button to each of your windows: 

 
Fig. 3: The Find Citations Button. 



TAMS Analyzer 3.53b9 Release Notes 

 

This release patches a number of small annoying bugs that have plagued TAMS for a while. 

None of these bugs were fatal. 

 

Bug Fixes 

1. The back button for hot codes on both the SEARCH and SETS tabs now works if  a 

(named) code set is loaded as the first hot code set. 

2. Insert time code button on document windows now works correctly, which means it 

functions the same as the menu command. Time codes will now be coded if you use 

the button without modifiers. With the apple/command button it inserts the time 

without code. With the option it can do a variety of things depending on program 

preferences. 

3. Small results window (set in the options) now is updated with padding controls and 

small fixes to the compare data report. 

Interface changes 

1. If you use AND (+) in a simple search you are now given the option of running it 

as an unlimited search rather than stopping the search. 

2. Column selections in result windows are now maintained between actions 

3. Select field to browse now uses the current selected column rather than a dialogue 

box. The icon has been changed and renamed to “Browse column.” 

4. Quicktime stuff has been refactored into two classes that can be easily re-written 

for GNUstep: MWAVMediaFile and MWAVMediaView. 
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TAMS Analyzer 3.61b16 Release Notes 

 

This version updates a number of features. File and Code sets in particular are given a couple 

of feature boosts. 

 

New features: 

1. Time codes in seconds can now be sloppily selected when jumping to a time code. 

Previously the time had to be selected exactly (no additional characters, not even the tags 

that surround the time, could be included). 

 

2. Find paired tags now accepts sloppier selecting. Users no longer need to click inside 

the tag, but can select the whole tag when searching for a paired tag. 

 

3. Import definition and codes from code file now properly interprets escape characters. 

 

4. Double clicking a code or file in the sets panel (code and file tabs) now indicates which 

code sets include that code by selecting them in the code set list. (see Documentation 

below) 

 

5. Clicking multiple file and code sets (previously not allowed) selects all the codes from 

those file sets allowing you to create new file sets by combining others. Use the 

command and shift keys to extend selections. 

 

6. In the sets and tags pane, there is now a count for the number of code sets and file sets. 

 

Change in behaviors: 

1. Creating or modifying a File set no longer automatically “loads” that file set. 

 

2. Buttons on the search tab now combined into a menu 

 

Bug fixes 

1. Interface repaired for file tag tab so labels and fields resize correctly 

 

2. Buttons on file tab changed so they are Panther compatible 

 

3. File sets menu and select more (and other functions) work with each other; previously 

using the file set menu did not register the file set so that select more (and maybe 

other functions) did not work correctly 

 



  Documentation 

 

Finding the file sets or code sets that contain a particular code. 

 

In previous version this could be done through generating a graph of the code sets, but often 

you don’t want anything as formal as a graph, you just want to see which code sets contain a 

particular code. Now this can easily be done on the sets tab of the work bench: 

 
Figure 1: How to find out which sets hold a file 

 

The same procedure will work with codes on the Codes tab of the Tags & Sets tab. 
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Release Notes for TAMS Analyzer 3.70b5 
 
This release is a major number bump for a reason. There are new features, major bug fixes, 
logical enhancement, and then some “behind the scenes” activity—all described below: 
 
New Features: 
1. Value sets: create arbitrary groups of values (in one table column)  (See documentation 
below, section I) 
 
2. Select results based on value sets 
 
3. Edit value sets 
 
4. Create file sets based on current selection in results (See documentation below, section II) 
 
5. Filter results by file set 
 
6. Ability to intersect (in addition to combine [union]) sets through selecting multiple set 
names in the tags and sets tab. (See documentation below, section III) 
 
7.  Multiuser TA: ability to put project files in the “trash.” This will delete those files as users 
synch with the database (See documentation below, section IV) 
 
8. Multiuser TA: Principle Investigators can empty the trash, or untrash files; all users can 
view files. 
 
Interface Changes 
1. Menu keyboard shortcuts for next and previous on the project menu have been changed to 
remove redundancy (those key shortcuts were used everywhere) 
 
2. Multiple code sets can now be selected on the codes set subtab on the “tags and sets” tab. 
 
3. Warnings added for addcode, recode and the other recode menu options to warn users that 
they need to “mark” the records they want to change 
 
Bug fixes 
1. Project window no longer accepts Apply code 
 
2. Bug fixes for multiuser tams to facilitate connectivity in tams. 
 
3. Bug fix to allow the user to enter larger file sizes for multiuser tams  upload. 
 
Code base changes 
1. Multiuser and Single user are now two different targets in the same XCode project 
 
2. XCode 3.2.1 is now required to maintain the code (still using GCC 4.0) 
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Documentation 
 
I. Value Sets 
 
Value sets are simply a collection of values in a particular table column which can then be 
used to filter your results. Code sets have long acted as a value set for the _code column. 
Value sets simply generalizes this idea to any  text column of your results window. 
 
A. Creating Value Sets 
 
Create a selection of rows that has a set of values you would like to preserve. For instance if 
you have a “Interviewee” context variable, you could create a value set of “Interviewees that 
use Code X” by  
1. Selecting code X 
2. Clicking on the “Interviewee column” (clicking it’s header) 
3. Picking Results->Value sets->Create value set… 
 

 
Figure 1. Value Set Menu 

You will be prompted for a name. You can se spaces and other characters: there are no 
specific limits on what a code set name can contain, but they may be truncated in certain 
panes. 
 
B. Using Value Sets 
TAMS provides a variety of set operations to allow you to filter your results by value set. 
These operations all operate on the current selection in your results window. To filter (either 
additional records or fewer records) pick Results->Value sets->Value set operations… Figure 
2. shows the choices you will have (if you have created value sets) 
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Figure 2. Value set operations 

 
Here you pick the type of set operation you want applied (with the current selection) and the 
name of the value set to interact with: 
 

• Union: Combines the given set with all instances (rows) that satisfy the vale set. 
• Intersect: Reduces the current selection to only those that satisfy the value set you 

choose. 
• Not intersect: Combines the current selection with those that satisfy the value set you 

choose, but removes those from the current selection that would exist at the 
intersection 

• Less: Simply subtracts out records from the current selection that satisfy the value set 
you choose 

 
C. Editing value sets 
You can hand edit the values collected in a particular value set by bringing up the value set 
editor: Results->Value sets->Edit value set… The pane shown in figure 3 shows the editor 
and the set selector menu: 
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Figure 3. Value Set Editor 

 
Pick the value set from the menu, and a text edit appears. You can copy the values into 
another program to make a chart and use these values for reporting purposes or edit them, 
just putting a return between each value.  Returns and tabs internal to each value will appear 
as escape characters (\n, \t). 
 
D. Deleting value sets 
To drop a value set simply pick Results->Value sets->Delete value set… Just pick the value 
set to delete from the menu. (See Figure 4.) 
 

 
Figure 4. Deleting Value Sets 
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II. File set operations in the results window 
Until this release file sets were basically just to facilitate project management. They had no 
analytic function. Results windows had no access to the file sets, unlike code sets. With this 
release, results windows can both be filtered by file sets and file sets can be created from the 
documents included in any particular selection. This means you can create a file set that is 
“Files that contain code X,” for instance. Any selection can be represented as a file set. In 
essence, file sets are just value sets of the _doc column. Unlike value sets which are stored in 
the results window (they are not globally available at this point), file sets are stored in the 
project file/window and thus can be accessed everywhere. Deleting file sets and editing them 
is still handled in the project window’s tags and sets tab. Finally the set operations you can 
use are identical with those described in section I under figure 2. 
 
III. Combining (union and intersect) code and file sets in the Tags & Sets tab 
In theory forming a union of two code sets was available in the last release. In practice a bug 
kept this from being available for code sets (but not for file sets). To combine sets simply 
select them in the upper right table of the code sets manager (I’ll just address code sets, but 
this all applies to file sets too) and the result will be indicated in the Codes table in the lower 
left corner. This figure 5 walks through the steps of combining sets. 
 

 
Figure 5. Combining Sets 

1. Select the sets 
you want to 

combine here

2. If you want to 
intersect the sets 
click this button. 
By default it will 
be a union of the 

selected sets

3. The combined 
members of the 
set are selected 

here

4. To create a 
new set, click 
the add button. 
Then you can 
can fill in a 

name at the top 
and click the 
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Example of a problem that needs these new features: 
 
Final thoughts about the features described in sections I-III above. These features 
were developed because one TA user asked how to select records that met exactly 
the following conditions: All codes X and Y from files that must contain both X and Y.  
While there were lots of ways to visually get this information: either with a select near 
or with a data comparison table, for instance; these solutions involved visually 
looking through a lot of noise to identify the answers. The new features allow, with a 
bit of work, getting exactly these results. One way might be run an unlimited search 
and selecting X and creating a file set of “Files that contain X” and repeat for “Files 
that contain Y”. Now using the workbench create a file set of the intersection of these 
two file sets following the steps described in section III (“Files that contain X & Y”). 
Now you can make a search list of “Files that contain X & Y” and look for X and Y.  
 
Alternatively you could do an unlimited search, select code X, and make a value set 
of the _doc column called “files that contain X”; similarly make a value set for “files 
that contain Y”. Now select all records that have X and Y (use select and then select 
additional), now filter these results by intersecting this selection with the two value 
sets you created. 
 
These are awkward, but they do make available specific selections that previously 
were not possible. 
 
IV. Garbage management in Multiuser TA 
In previous versions of TA there was no means to really remove a file from a project. Using 
the traditional “Remove” button would temporarily dispose of the file, but synching with the 
project database would restore the file. Administrators would have to go in and delete the file 
after everyone had thrown it out.  
 
With this release TA helps manage that process. PI’s (principle investigators) can select files 
on the files tab of the workbench and push the new trash button. The files must be checked in 
for this to work. This will change the holder of the file to “__trash” and remove the file from 
the PI’s project. As other people synch, this file will be removed from their projects as well. 
No new files with the name of the trashed file can be added or imported, however. That is, 
they can’t be added until a PI empties the trash. The PI will need to use email (or some other 
means) to make sure that everyone has synched or manually removed the file. Once this is 
confirmed they should press “show trash” on the files tab and click the empty trash button. 
This will free that file name for others to reuse. The PI can also  empty the trash of specific 
items by selecting them in the “Show trash” pane. In addition, the  PIs can undelete (restore 
to the library) items in the trash by selecting them and pressing the “Undelete” button. These 
buttons will not be visible for those who are not PIs. 
 
See Appendix 4 of Using TA3 with Multiple Researchers for more details. 
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TAMS Analyzer 3.72b15 Release Notes 
 
This is a bug fix and feature smoothing release. Some of the bugs are important, but none 
program crashing or so serious as to prevent analysis of data. 
 
Interface changes 

• Holder column will now *not* resize when window resizes 
• Axis information in Data Comparison Tables (DCT) is a little more informative 
• Results window will restore table view (vs. outline view) when quitting the DCT 

panel 
• DCT now selects _data as the default for table data elements 

 
Bug fixes 

• Critical bug fix for single user version. Now users can remove files from the project 
• Important bug fix for single column DCTs which had no actual data to show 
• Resizing of both the small and large panel versions of DCTs now works. Before it left 

table elements drifting all over each other 
• Zeros (0) in counts now obey the formatting rules in terms of vertical and horizontal 

justification 
 
Other 

• DCT documentation brought up to date in both the user manual and tamsZine #2. 
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